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Measurement gear 

• Microphone with calibration file 

• Soundcard with 2 analog input channels. Left input for mic and right input from output of soundcard. Analog 

output (left) to amplifier to driver under test 

• Room EQ Wizard V5.20.14ea27 or later. Current version while writing this document: V5.20.14ea27 

• Computer with Windows, macOS or Linux 

• Mic cable, USB cable, signal cable, loopback (patch) cable and speaker cable 

• Integrated or power amplifier 

• Turning table 

• Wireless keyboard is very handy with manual turning table. 

Note! Single channel measurement systems such as USB microphones (with latency variations by default) are not 

recommended for speaker engineering due to timing and phase variations and normalizations. REW should NOT be 

used without electrical loopback as timing reference or cal and timing reference for acoustical measurements to 

avoid timing manipulation by the program. 

Impedance measurements 

1) Measure impedance response with phase of one woofer if all drivers have own box. If drivers share the same box 

volume, they should be measured together in series or parallel - like in the final connection. 

2) Measure impedance response of one mid-range driver if all drivers have own box. If drivers share the same box 

volume, they should be measured together in series or parallel - like in the final connection. 

3) Measure impedance response of tweeter. 

Measurement connection, copied from REW Help: 

 

REW Help, Impedance Measurement: 

Good results can be obtained using a headphone output (or, even better, a good headphone amplifier or a device 

with a high power headphone output) to drive the load, with a 100 ohm sense resistor. If a line output is used the 

sense resistor typically needs to be larger as line outputs have high output impedance and limited drive capability, try 

1 kohm but note that the results will have much higher noise levels and be more susceptible to background noise. If 

the device being used to drive the load can cope with lower loads a lower sense resistor, 47 ohm for example, will 

improve the results. 

An alternative is to drive the load via a power amplifier, which can deliver the lowest noise levels and most accurate 

results, but great care must be taken as the levels a power amplifier can generate can easily damage soundcard 

inputs. If using a power amplifier the sense resistor can be much lower, 33 ohms or less, but the soundcard inputs 



should be connected via a resistive divider providing around 20dB of attenuation and ideally the inputs should also be 

protected by back-to-back zener diodes to clamp the input to less than 5V. 

You can also use different gear and software such as DATS (Dayton Audio Test System). 

Gear setup for acoustical measurements 

Set up measurement gear for semi-dual or full-dual channel acoustical measurement. 

Normal semi-dual connection (without high-pass filter for driver protection). 

 

Typically microphone input of soundcard includes preamplifier and 48 V phantom power supply so external 

preamplifier is not needed. 

Select Timing: ‘Use loopback as timing reference’ in Measurement window for low quality soundcard with significant 

crosstalk or DC offset. 

Select ‘Use loopback as cal and timing reference’ and ‘Merge loopback response into IR’ for high quality soundcard 

with very low crosstalk and DC offset. Check High pass in Preferences Soundcard if you suspect that DC offset or LF 

noise damages the measurements. 

Semi-dual connection with active high-pass filter to protect fragile drivers from high excursion. High quality 

soundcard with very low crosstalk and DC offset is required. 

 

Select Timing: ‘Use loopback as cal and timing reference’ and ‘Merge loopback response into IR’ in Measurement 

window. Check High pass in Preferences Soundcard if you suspect that DC offset or LF noise damages the 

measurements. 

Full dual connection with capacitor to protect fragile drivers from high excursion, and power amplifier from very low 

impedance due to transformer. High quality soundcard with very low crosstalk and DC offset is required. 



 

Select Timing: ‘Use loopback as cal and timing reference’ and ‘Merge loopback response into IR’ in Measurement 

window. Check High pass in Preferences Soundcard if you suspect that DC offset or LF noise damages the 

measurements. 

Right and left channels should be swapped with soundcards having phantom power in the right channel only. 

Preferences 

Start REW and open Preferences window. 

Soundcard tab 

Select Driver, Sample Rate=88.2 kHz, Device, Outputs and Inputs. 

Example with Focusrite Scarlett 2i2: 

 

Cal Files tab 

Soundcard calibration is not needed when Timing: ‘Use loopback as cal and timing reference’ is selected in 

Measurement window. Create and load soundcard calibration file if you must select ‘Use loopback as timing 

reference’ due to low quality soundcard. 

 

Load microphone calibration file: 

 



Analysis tab 

Set initial settings for Impulse Response (IR) window. Short initial time window such as Left=2 ms, Right=5 ms is 

suitable for quasi far field measurements in limited reflective space indoors. Long initial time window such as 

Left=100 ms, Right=1000 ms is suitable for near field measurements and real far field measurements in anechoic 

chamber. Tukey 0.5 or 0.75 window function is recommended to avoid response overshooting at low mid when 

measuring LF driver with short time window. 

 

Clock adjustments and time alignments are not needed so you can uncheck all in Impulse Response Calculation 

group: 

 

Verify that ‘Limit cal data boost to 20 dB’ is unchecked especially if ‘Make calibration data from loopback response’ is 

(accidentally) selected in Measurement window and loopback includes high-pass filter for protection. 

 

Turning table 

Prepare manual turning table with angle scale -180…+180 deg, steps 5 or 10 deg. Diameter 80…120 cm depending on 

speaker size. This makes measuring process easy and fast. 

Terminology 

Few terms need to be defined first: 

• X-axis is horizontal from left (-) to right (+) when observer is in front of speaker. 

• Y-axis is vertical from floor (-) to ceiling (+). 

• Z-axis is horizontal from microphone (-) through the driver to front wall (+) when measuring axial response 0 

degrees hor & ver. 

 



Rotation: Horizontal plane (top view) Vertical plane (left view) 

  

  



Far field measurements 

Clear measurement list with Remove all button. 

Open Make a measurement window (Measure button or Tools->Measure or Ctrl+M). 

 
Settings: 

Type: SPL 

Name: Root filename; driver’s (short) name and measurement plane hor or ver, for example 

  M15CH002 hor 

Select Add number radio button. Open numbering setup window with dialog icon/button on the right. Set 

Next number to the 1st off-axis angle to be measured, and Increment to angle step of measurement sequence. 

Examples: 

* 0…+180 deg with step of 10 deg: Next number=0, Increment 10 

* 0…+90 deg with step of 10 deg: Next number=0, Increment 10 

* -170…+180 deg with step of 10 deg: Next number=-170, Increment 10 

* -90…+90 deg with step of 10 deg: Next number=-90, Increment 10 

Sample Rate: 88.2 kHz 

Range: 5…41000 Hz (full range to avoid extrapolation of response files in VituixCAD) 

Level: -10 dBFS 

Method: Sweep 

Length: 1 M (11.9 s) 

Repetitions: 1 

Timing: ‘Use loopback as cal and timing reference’. 

  ‘Use loopback as timing reference’ if problems with DC offset or LF noise. 

  See ‘Gear setup for acoustical measurements’ for more information. 

Timing offset: 2.907 ms with 1000 mm measurement distance from mic to rotation center,  

  with analog electronics without processing delays. 

  Delay [ms] = measurement distance [mm] / 344 + possible processing delay [ms] of DSP 



  Select ‘Merge loopback response into IR’ 

Playback from: REW 

Measure far field responses of woofer and mid-range driver and tweeter at 1000 mm in horizontal plane around the 

speaker. Large constructions and deep horns may need longer than 1000 mm for example 3x baffle width to capture 

far field response more compatible with response at typical listening distance. Long planars/ribbons should be 

measured at typical listening distance. Measure single side 0, 10, 20, …, 180 degrees in horizontal plane if speaker is 

horizontally symmetrical. Very asymmetrical constructions such as classic 3-way should be measured to both 

negative and positive off-axis angles: -170, -160, …, 0, …, +170, +180 degrees. Wall speakers should be measured and 

simulated to half space, and corner speakers to quarter space in hor plane and half space in ver plane (see VituixCAD 

Options). Full range horn speakers can be measured to half space only due to low pressure at rear. Angle step could 

be 5 degrees at least within listening window to get more accurate average with radiators having dense on-axis 

response deviations. 

Basic rules: 

• All far field measurements must have the same signal level from power amplifier. Amplifier volume, 

microphone sensitivity and other volume potentiometers should not be touched between measurements of 

different drivers. 

• 1st order reflections should be avoided or delayed. Measure drivers at about half of room height. For 

example, upper mid-range driver and 3rd woofer from the floor with WWMTMWW to get maximum 

possible distance for floor and ceiling reflections. Absorb with large and soft pillows on the floor and ceiling if 

possible to enable time windows longer than 4 ms. >150 cm from rotation center to the walls. 

• Measurement Name must have valid coding for plane and off-axis angle. 

<drivername> <plane> <angle> where <plane> is hor or ver and <angle> is off-axis angle in degrees is 

recommended with manual turning table. 

For example M15CH002 hor 110 equals M15CH002 to +110 degrees off-axis in horizontal plane. 

Single axial measurement (without off-axis responses) could also have plane and angle coding with ‘ hor 0’. 

• Elevation of mic is at the center point of driver under test i.e. mic and driver have the same Y-coordinate in 

mm. Turn speaker back or front if front baffle is tilted. Tilt turning table with ground plane measurement to 

aim driver’s axis towards the mic while hor 0 deg measurement. 

Exception 1: Mid and tweeter can be measured at common mic elevation = average Y of center points if 

drivers are small and close to each other, baffle is straight (non-stepped) and vertical plane is not measured 

i.e. drivers are circular and hor/ver difference in baffle diffraction is ignored on purpose. 

• Rotation center on X-axis while off-axis measurement sequence is at the center point of driver under test. 

• Rotation center on Z-axis while off-axis measurement sequence: 

a) Rotation center on Z-axis is common for all drivers if drivers are installed in straight non-stepped 

baffle. Rotation center is typically on surface of front baffle for the tweeter. Set Z=0 mm for all driver 

instances in crossover simulation regardless of difference between baffle surface and acoustical 

center. 

b) Rotation center on Z-axis varies with stepped baffle. Drivers on each baffle level has own rotation 

center on Z-axis. Distance from each baffle level to microphone should be the same (1000 mm). 

Differences on Z-axis are entered to the simulator as Z mm of driver instance in XO. For example, 

tweeter Z=0 mm, mid-range Z=-20 mm, woofer Z=-100 mm. 

• It’s best to measure all drivers to same off-axis angles. Subwoofers too if they are included in the same 

construction, and power response and DI are simulated with the other drivers. 

• Asymmetrical rectangular radiators such as AMTs and ribbons as well as elliptical and rectangular horns with 

height <> width must be measured in both planes. 

• If vertical plane is measured, it’s best to measure the same off-axis angles than in horizontal plane to avoid 

mirroring from horizontal to vertical and vice versa in case Mirror missing is unchecked in VCAD Options. 

Measurement of vertical plane can be skipped if the driver and possible wave guide/horn are circular i.e. 

directivity in vertical plane is equal to horizontal plane. Skipping of vertical plane could cause small hump (< 

1 dB) to power response at diffraction peak frequency if baffle height is much longer than width. In that case 



sound balancing should be weighted by on-axial response around diffraction peak frequency (wave length = 

baffle width). 

Verify with SPL graph that all far field measurements are okay. Save all measurements of one driver to single 

mdat file. 

For information: Phase response of dual channel measurement includes difference between rotation center and 

actual acoustical center of driver. Phase response includes also extra travel distance from radiator's throat via 

possible wave guide/horn and around box edges including delayed diffractions when speaker is rotated >90 deg 

while off-axis measurement sequence. 

Note! Z difference between rotation center (on baffle surface) and actual acoustical center of driver should never 

be entered to Z mm coordinate of driver instance in crossover simulation with unidirectional drivers such as boxed 

speakers and horns to avoid geometry calculation error which would cause immediate response summing error 

to off-axis directions. Z mm of all driver instances in crossover should be 0 mm with dual channel measurements 

described in this document. 

  



Near field measurements 

Clear measurement list with Remove all button. 

Open Make a measurement window (Measure button or Tools->Measure or Ctrl+M). 

Most of the settings are the same with far field measurements. Exceptions: 

Name: Not formal. For example, driver’s (short) name and ‘near’ and ‘cone’ or ‘vent’, 

M15CH002 near cone, L22RNXP near vent or SP22R near (passive is just cone) 

 Select Use as entered radio button to avoid automatic numbering 

Level: -30 dBFS 

Timing offset: 0.000 ms, because measurement distance is just few millimeters. 

Do not touch volume controls of the amplifier and microphone input by default. Decrease with volume 

potentiometer if mic input clips (red led flashes) when measuring reflex port or midrange driver at near field. 

Locate woofer cone close to floor or wall to make half space conditions at LF. Measure near field response of one 

woofer cone at 5 mm from the center of dust cap. Measure at 5 mm from cone close to phase plug if the driver has 

phase plug. If two woofers have shared box, feed signal to both woofers and isolate (not brake) the other (which is 

not under test) with pillow to prevent midrange frequencies going to mic too much. 

Measure near field response of reflex port(s) or passive radiator(s). Mic in the center of vent at baffle surface if vent 

is not rounded. If vent has rounding, penetrate few millimeters inside where tube with constant diameter begins. 

Measure near field response of one mid-range driver at 5 mm from center of dust cap. Measure at 5 mm from cone 

close to phase plug if the driver has phase plug. 

Verify with SPL graph that all near field measurements are okay. Save all near field measurements to single mdat file. 

Useful metadata with the measurements for VituixCAD operator 

• Drawing of front baffle; dimensions, driver locations, edge radius (locations specified if radius variates 

much). 

• Type of drivers, or at least Sd or Dd for magnitude scaling. 

• Dimensions and number of reflex ports or passive radiators. 

• Typical listening distance. 

• Room acoustics measurements. Measurement at listening position, from left and right channel separately, 

with common small 2-way or 3-way, sine sweep 1M, about 80 dB SPL. 

• Sketch of listening room dimensions and layout. Construction materials and location of possible acoustic 

panels and diffusers. 

Hired VituixCAD operator can do the rest. If you hire VituixCAD operator, zip all measurement files (.mdat) files and 

calibration files and metadata and send by e-mail. 

  



Example 

Exporting far field responses 

Export far field responses of tweeter 

Clear measurement list with Remove all button. 

Open far field measurements of tweeter. Select axial response ‘ hor 0’. Select Impulse graph tab. Set Y-axis unit to %. 

Click IR windows button to adjust gating. Set Left window Tukey 0.5, length 2.0 ms. Right window Tukey 0.5 or Tukey 

0.75. Adjust window length so that time window ends in the beginning of the first reflection. Show Impulse Envelope 

(ETC) if Impulse trace does not reveal the first reflection. You can calculate preliminary value with Auxiliary Time 

window calculator of VituixCAD. Click Apply Windows to All and Save mdat. 

 

Export frequency responses with File -> Export -> Export all measurements as text. Settings: 
  Use custom range: 5 to 40000 Hz 
  Use custom resolution: 48 PPO 
  Use smoothing of measurement: 1/24 octave 
  Use REW export format (recommended): 12345.6 
  Use a separate file for each measurement 
    File extension: .frd 
    Export units: SPL 
    Export text delimiter: Tab 



 

Click OK and export to username\Documents\VituixCAD\Projects\projectname\drivername\Far -directory. 

Export far field responses of mid-range driver 

Clear measurement list with Remove all button. 

Open far field measurements of mid-range driver. Select axial response ‘ hor 0’. Adjust time windows, Apply 

Windows To All, Save mdat and export response files with previous settings to 

username\Documents\VituixCAD\Projects\projectname\drivername\Far -directory. 

Export far field responses of woofer 

Clear measurement list with Remove all button. 

Open far field measurements of woofer. Select axial response ‘ hor 0’. Adjust time windows, Apply Windows To All, 

Save mdat and and export response files with previous settings to 

username\Documents\VituixCAD\Projects\projectname\drivername\Far -directory. 

Exporting of near field responses 

Export near field response of woofers, ports, passive radiators and mid-range drivers 

Clear measurement list with Remove all button. 

Open near field measurements. Select response of mid-range or woofer cone. Set Right window Tukey 0.5, length 

1000 ms. Click Apply Windows To All, Save mdat and and export response files with previous settings to 

username\Documents\VituixCAD\Projects\projectname\Near -directory. 

  



VituixCAD Options 
Verify that Number format of angle coding is compatible with your response files. Listening distance is your typical 

listening distance, but don’t set shorter 2000 mm. Check Mirror missing angles in Frequency responses group. Verify 

that parameters in Power response & DI Calculation group are the following (check also Half space with wall 

speakers, when measurements cover 0…90 deg only): 

 

  



Baffle diffraction simulation 

Simulate cabinet impact response of woofers 

Include woofers representing average of all woofers. Two woofers represent all four in this (WWMTMWW) case. Set 

mic on lower woofer. See parameters below. Export two cabinet impact responses without directivity: with Axis 

Distance of 5-30 meters and actual far field measurement distance, typically 1000 mm. Save diffraction project as 

username\Documents\VituixCAD\Projects\projectname\drivername.vxb for possible modifications. 

 

Simulate cabinet impact response of midrange driver 

Include single driver if it represents all. Set mic in the center point. See parameters below. Export two cabinet impact 

responses without directivity: with Axis Distance of 5-30 meters and actual far field measurement distance, typically 

1000 mm. Save diffraction project as username\Documents\VituixCAD\Projects\projectname\drivername.vxb for 

possible modifications. 

 

  



Merging of near and far field responses 

Merging of woofer responses 

Load near field responses to Low frequency part. Check BS if radiating surface is in the front baffle (having baffle 

step). Enter Diam mm or Area cm2 for each NF response representing single radiating surface. Enter Count >1 if 

more than one radiating surfaces use the same NF response. Check Force to Gradient and frequency if you want to 

force polar pattern below entered frequency. 

Select Diffraction response option and Load Diffraction response simulated to 5-30 m. 

Load far field measurements to High frequency part. 

Load Diffraction response simulated to actual measurement distance, for example 1000 mm. 

Total level of near field responses in Low frequency part is adjusted manually with Scale [dB] until levels match 

within blending range, especially within 300…600 Hz.  

Delay [us] is set automatically while adjusting Transition frequency. 

Blending range of 1 octave is usually okay. 

Export merged responses as FRD with Save button to 

username\Documents\VituixCAD\Projects\projectname\drivername\Merged -directory. 

Save merger project as username\Documents\VituixCAD\Projects\projectname\drivername.vxm for possible 

modifications. 

 

See user manual for more information.  

  



Merging of mid-range responses 

Same procedure with woofers. 

 

Merger video lesson (old version): 

https://www.youtube.com/watch?v=cUGDhpleWD0 

https://www.youtube.com/watch?v=cUGDhpleWD0

